
Overview
This chapter presents a series of basic tutorials that demonstrate various
HVE-CSI techniques and capabilities. The purpose of these tutorials is to
provide a solid grasp of the fundamentals of using HVE-CSI, and to help the
user become as efficient as possible. This is accomplished through a series of
high-level, task-oriented procedures using a step-by-step approach.

While this tutorial explores many of HVE-CSI’s important features, it does not
provide detailed explanations. For these details, the tutorial refers to specific
chapters, and the user should refer to those chapters when necessary.
Additional information, including a comprehensive index, may be found in the
Appendix.

� NOTE: In addition to this tutorial, EDCRASH and

EDSMAC have Program Manuals that include a

comprehensive tutorial.
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The Tutorial is divided into four individual lessons:

• Lesson 1 - Navigating in HVE-CSI - This lesson is shows
techniques that promote efficiency. The user learns how to move
quickly within HVE-CSI to perform fundamental tasks.

• Lesson 2 - Running a Simulation Model - This lesson shows
the best way to set up and execute HVE-CSI compatible physics
models (reconstructions and simulations involving vehicle
dynamics).

• Lesson 3 - Combining Multiple Events - This lesson
explains how to merge two or more individual simulations into a
coherent and seamless sequence involving multiple vehicles.

• Lesson 4 - Creating a Video - This lesson provides a quick
and easy lesson describing how to create your first video.

Let’s begin with the first lesson.

Lesson 1 - Navigating in HVE-CSI
Lesson 1 is a lesson in fundamentals, with an emphasis on efficiency. In this
lesson you will learn to perform the following fundamental tasks:

• Starting HVE-CSI

• Learning About the Menu Bar

• Managing Dialogs and Viewers

• Choosing an Editor

• Using Dialogs

• Using Viewers

• Shutting Down HVE-CSI

Do not skip this lesson! By spending time performing these tasks, you will be
able to navigate within HVE-CSI more quickly, more efficiently and (perhaps
most important) more intuitively! You’ll be able to effortlessly view the action
from the desired viewpoint. You’ll be able to set up your viewers to gain
maximum efficiency and information from what HVE-CSI is telling you. Put
simply, this lesson helps you get the most out of your HVE-CSI system. Let’s
get started.

Starting HVE-CSI

To start HVE-CSI, use the Start, Programs cascade menu to select the HVE-CSI
program menu and then the HVE-CSI program icon, just as would start any other
program on your computer. After starting HVE-CSI, the HVE-CSI Menu Bar
and current HVE-CSI Editor are displayed (in this case it is the Vehicle Editor), as
shown in Figure 17-1.
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� NOTE: HVE-CSI saves the current editor when you exit;

thus, the editor now displayed is the one you were using

when you last exited HVE-CSI.

Learning About the Menu Bar

We will be using many terms throughout this (and other) tutorials. If you have
not worked with Windows before, many of these terms will be new to you. The
actions you will be performing will be new as well.

Let’s start off by identifying and experimenting with the components that
make up what is called the Menu Bar. Many of the functions accessed using
the menu option may also be selected by clicking on various toolbar buttons.
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Menu Bar

A Menu Bar, shown in Figure 17-2, is common to all Window-type programs.
It contains the program’s fundamental options. In the case of HVE-CSI, these
options are File, Edit, View, Mode, Set-up, 3D-Edit, Options and Help. Let’s
briefly explore these options:

� Click on File. The File menu is displayed. This menu provides

basic system operations, such as starting new cases, opening and

saving files, working with video, printing and exiting HVE-CSI.

� Click on Edit. The Edit menu is displayed. This menu provides

operations that allow you to edit selected objects.

� NOTE: No Edit menu options are currently available

because no object is selected. Other menus will also

have disabled options until the appropriate situation

allowing the use of the option is present.

� Click on View. The View menu options are displayed. This

menu provides operations that determine how you look at

simulations.

� Click on Mode. The Mode menu options are displayed. This

menu allows you to select which Editor you are currently

using, and also to add new or previous objects into the Editor

(e.g. Select Mode, Add, New or Previous).

� Click on Set-up. The Set-up menu options are displayed. This

menu allows you to enter inputs for setting up your simulation

or reconstruction events.

� NOTE: The 3D-Edit menu is not used by HVE-CSI.
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� Click on Options. The Options menu is displayed. This menu

provides several user-definable options and preferences.

� Click on Help. The Help menu is displayed. This menu

provides access to the various HVE-CSI Help System options.

The Dialog Control button is located in the upper left corner of the Menu Bar;
see Figure 17-2 (a), on the previous page.

� Click on the Dialog Control icon. The dialog control options

are displayed. These options allow you to move the dialog,

change its size, minimize it (replace the dialog with a small

icon - handy if you’re not currently using the dialog), and

maximize it (make the dialog as large as possible).

All dialogs and viewers have a Dialog Control button.

The Menu Bar also includes the Title Bar. This component (b) displays the
current case title, followed by the current filename in parentheses. All dialogs
and viewers also have a Title Bar, and it has an important function:

� Click on the Title Bar and drag the mouse. The dialog (i.e., the
HVE-CSI program window in this case) follows your mouse
cursor. This is a fundamental navigation task that allows you to
move dialogs and viewers anywhere you wish.

The Active Objects List is integrated into the Menu Bar. This component (c)
displays a drop-down list of active objects while in the Vehicle, Environment,
Event and Playback modes. By clicking the button on the right side of the list,
the complete list of objects is displayed. The current object is displayed in the
viewer. To add a new object to the list, click on the Add New Object button
(looks like a + sign) located two buttons to the left of the list on the toolbar. To
display the Information dialog for the current object, click on the Object Info
button (looks like a hand pointing) immediately to the left of the list on the
toolbar.
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The Current View List is also integrated into the Menu Bar. This component
(d) displays a drop-down list of active cameras while in the Environment,
Event and Playback modes. By clicking the button on the right side of the list,
the complete list of views is displayed. The current view is displayed in the
viewer. To display the current camera information or to add a new camera
view to the list, click on the Camera Setup button (camera icon) locate to the
left of the list on the toolbar.

The Event (and Playback) Controller is integrated directly into the Menu Bar.
The functionality and related information displayed by the Event Controller
are shown in Figure 17-5. The data fields are as follows:

• Current Simulation Frame - Displays the current frame of

simulation output. A frame is equivalent to one timestep of output.

• Max Simulation Time - Displays the selected Simulation Controls

Maximum Simulation Time termination condition.
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• Simulation Timestep - Displays the integration timestep used for

typical vehicle trajectory calculations as set in Simulation Controls.

• Current Simulation Time - Displays the current timestep of the

complete event.

• Output Interval - Displays the timestep interval used for display

results as set in Simulation Controls.

The Event Controller Slider can be used to move forward or backward through
each simulation frame. This provides the user with an easy means to locate a
specific point in a simulation, without having to Play and Stop the simulation.

The Menu Bar includes Minimize and Maximize buttons, as shown in Figure
17-2 (g).

� Click on the Minimize button. The dialog disappears!
Actually, it turned into an icon and is displayed along the
bottom of the Windows desktop.

� Click on the HVE-CSI icon. The current HVE-CSI program
window is redisplayed.

� Click on the Maximize button. The Menu Bar fills the screen.

� NOTE: Using the Maximize button to maximize the
program window allows you to use the whole screen for
your work. Setting your display 1280 x 1024 resolution or
higher provides you with a larger work area.

� Click the Maximize button again (which is now the Restore
button). The dialog returns to its original size.

Finally, the Menu Bar (and all windows and dialogs) includes a dialog frame
that surrounds the dialog. The dialog frame has two functions:

� Click on the frame and drag the mouse. The dialog changes size.

Depending on where you click on the frame, the dialog changes size in the
direction you drag. If you click on the corner, it changes size in both directions.

� Click and drag on various parts of the dialog frame,
experimenting with this feature.

� NOTE: Some dialogs cannot be resized.

The second function of clicking on the frame is that it raises the dialog to the
top of the display, a useful feature if the dialog is partially covered and you
need access to it. We’ll explore this use later in this tutorial.
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Viewers

Viewers are used to display objects. A typical viewer is shown in Figure 17-6.

Viewers have the same window manager components that were just explored
using the Menu Bar. In addition, viewers also have the following components:

• Viewer Mode Selector - This component, shown in Figure 17-6 (a),

allows the user to switch between Pick mode, used for choosing objects

in the viewer and performing an editing operation on that object, and

Manipulate mode, used for changing the view using direct

manipulation.

• Viewer Controls - These components include Viewer X and Y

translation thumb wheels, shown in Figure 17-6 (b), Dolly thumb

wheel, Figure 17-6 (c), and Zoom slider, Figure 17-6 (d).

These components will be explored later in this tutorial.
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HVE-CSI Mode Selector

The HVE-CSI Mode Selector is integrated into the toolbar at the left hand side
of the Main Menu. As shown in Figure 17-7, the Mode Selector has five
buttons, as follows (left to right):

• Human Editor Button - Not available in HVE-CSI

• Vehicle Editor Button - Displays the Vehicle Editor, placing

HVE-CSI in Vehicle mode.

• Environment Editor Button - Displays the Environment Editor,

placing HVE-CSI in Environment mode.

• Event Editor Button - Displays the Event Editor, placing HVE-CSI

in Event mode.

• Playback Editor Button - Displays the Playback Editor, placing

HVE-CSI in Playback mode.

Let’s get a little practice using the HVE-CSI Mode Selector:

� Click on each button in the Mode Selector to display the

various HVE-CSI editors.
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Managing Dialogs and Viewers

Becoming an efficient HVE-CSI user requires using a few simple, but
important, procedures. These procedures include:

• Arranging your desktop to allow you to be as efficient as possible

• Raising viewers and dialogs to the top of the desktop

• Minimizing windows to help improve system performance
(especially for viewers that must be rendered)

Minimizing Windows

While using HVE-CSI, you may find your desktop becomes cluttered with
numerous data windows and viewers. This is especially true while using the
Playback Editor under the following two scenarios:

• You are working with a case that has multiple events and you have
created several output reports for each event.

• You are working with a case that has multiple Trajectory
Simulation windows and you are in the process of rendering the
Playback Window containing multiple Trajectory Simulation
events.

In these instances, you can minimize the window containing the report so it
takes less screen space.

� NOTE: A minimized window maintains all the data

associated with it; minimizing simply removes the visual

representation of the window and replaces it with an icon.

� NOTE: Minimized viewer windows are not rendered.

Because it takes time and computer resources to render

a window, minimizing viewer windows can significantly

speed up your work!

Let’s practice minimizing windows in the Playback Editor. Start by opening a
case:

� Click on File menu option and choose Open. The HVE-CSI

File Selection dialog is displayed.

� Select HVE-CSITutorLesson1EDC.hve and press OK.

� Choose No to the request to save the changes to the current case.

The selected case file is loaded into HVE-CSI and the Vehicle Editor displays
the current vehicle in the Active Vehicles list and viewer.

� Choose Playback mode. The Playback Editor is displayed, as

shown in Figure 17-8.

� Click on the Traj Sim window to bring it to the top of the desktop.
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� Click on the Dialog Control button and choose Minimize. The

Traj Sim window is turned into an icon as shown in Figure 17-9.
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Choosing an Editor

HVE-CSI is designed around five fundamental editors. These editors are:

• Human Editor - Not available in HVE-CSI.

• Vehicle Editor - Used for selecting and editing vehicles

• Environment Editor - Used for selecting and editing the
environment

• Event Editor - Used for setting up and executing reconstruction
and simulation models

• Playback Editor - Used for creating visual and numeric output
reports and simulation movies

This lesson teaches you how to quickly navigate between these editors. To
make this lesson a little more interesting and useful, we’ll use the current case
to illustrate the various HVE-CSI editors. Continuing from the previous
discussion, we’re in the Playback Editor. Let’s switch to Vehicle mode.

� NOTE: Switching to Vehicle mode is synonymous with

selecting the Vehicle Editor.

Switching editors is performed using the Mode Selector located at the left hand
side of the toolbar (refer to Figure 17-7). To switch to Vehicle mode:

� Press the Mode Selector’s Vehicle pushbutton. The Vehicle

Editor is displayed with the current vehicle, 1998 Chev C-10

Pickup, selected in the Active Vehicles list and displayed in the

Vehicle viewer, as shown in Figure 17-10.

Next, let’s display the Environment Editor. To switch to Environment mode:

� Press the Mode Selector’s Environment pushbutton. The

Environment Editor is displayed with the current environment,

Untitled Environment, displayed in the Environment viewer,

as shown in Figure 17-11.

� NOTE: There is no Active Environments list, because

there is only one environment.

� NOTE: The environment should appear as a

T-intersection, as shown in Figure 17-11 on the next

page. If the environment is blank, it is because your

installation directory for HVE-CSI is different from the one

used to create our HVE-CSITutorLesson1EDC.hve case

file. To remedy the problem, click on the Environment

Information button next to the Active Events List, choose

Open and select the 2t2-800ftx500ft image file.
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Switch to Event mode:

� Press the Mode Selector’s Event pushbutton. The Event Editor

is displayed with the current event, EDSMAC, Intersection

Collision, displayed in the Active Events list and displayed in

the Event viewer, as shown in Figure 17-12.

� NOTE: In this example, Key Results windows are

displayed in the Event Editor. To display Key Results

windows, choose Show Key Results from the Options

menu.

Switch to Playback mode:

� Press the Mode Selector’s Playback pushbutton. The Playback

Editor is displayed and several reports are displayed, as shown

in Figure 17-13.

� NOTE: The Playback Editor displays all selected reports.

This allows you to compare results from several events.
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Switch back to Vehicle Mode:

� Press the Mode Selector’s Vehicle pushbutton.

The Vehicle Editor is displayed with the current vehicle. Let’s display a
different vehicle in the Vehicle Editor:

� Click on the Active Vehicle list and choose 1998 Chev C-10

Pickup.

The 1998 Chev C-10 Pickup becomes the current vehicle and is displayed in
the Vehicle viewer.

Let’s take a look at 1998 Chev C-10 Pickup‘s basic vehicle attributes
dimensional and inertial properties using the Vehicle Wizard:

� Click on the Object Info button on the toolbar. The Vehicle

Information dialog (also called the Vehicle Wizard) for the

1998 Chev C-10 Pickup is displayed, showing its current

values; see Figure 17-14

� Press Cancel to remove the Vehicle Information dialog.
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Switch to Environment mode:

� Press the Mode Selector’s Environment pushbutton. The

Environment Editor is displayed with the current environment

in the viewer.

Let’s take a look at the current environment attributes. These are displayed in
the Environment Information dialog. To display this dialog, perform the
following steps:

� Click on the Object Info button on the toolbar. The

Environment Information dialog is displayed, as shown in

Figure 17-15.

The Environment Information dialog is used for assigning physical event
information (sun position and gravity constant, for NASA engineers doing
Martian vehicle simulation).

The Environment Information dialog may also be used for assigning an Aerial
Image file to drive on.

� Press Cancel to remove the Environment Information dialog.
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Using Dialogs

HVE-CSI has more than 50 dialogs for entering and editing information. All
HVE-CSI dialogs have default information already assigned. Therefore, when
using a dialog, you are always editing existing default data.

Modal vs Modeless Dialogs

HVE-CSI (and most other applications) use two different types of dialogs:
Modal and Modeless.

A modal dialog requires the user to complete a dialog operation by pressing
OK or Cancel before another action can be performed.

� NOTE: You cannot make any other program selection

until you OK or Cancel a modal dialog.
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On the other hand, a modeless dialog allows you to enter and edit data in the
dialog, as well as to make selections from the menu bar and manipulate objects
in viewers while the dialog is still displayed.

Let’s explore the use of these dialogs. First, let’s look at a typical modal dialog:

� Click on File menu option and choose Open. The HVE-CSI

File Selection dialog is displayed.

� Using the HVE-CSI Mode Selector, choose Event mode.

Note that HVE-CSI gives you either an audible (beep) or visual (dialog bar
blinking) cue. This happens is because the File Selection dialog is a modal
dialog. You cannot perform any other operations until the File Selection dialog
is removed, either by pressing the dialog’s OK or Cancel button.

� Choose Cancel. The File Selection dialog disappears.

� Choose Event mode. The Event Editor is displayed, and the

current event is displayed in the viewer.

Now, let’s look at a modeless dialog. One of the most important examples is
the Position/Velocity dialog used by the Event Editor:

� Click on the 2009 Ford Crown Vic in the Event viewer. The

Position/Velocity dialog for the current vehicle is displayed, as

shown in Figure 17-16.

� NOTE: You can tell right away that the Position/Velocity

dialog is a modeless dialog because it does not have OK

or Cancel buttons like a modal dialog.

Let’s get some practice using a modeless dialog:

� Place the mouse cursor in the Position/Velocity dialog’s X

coordinate field and change the value from -36.00 feet to

-32.00 feet.

� Press the <Enter> key or the Apply button. The vehicle’s

position is updated.

� NOTE: You will also notice that the vehicle has a set of

manipulators that allow you to drag and rotate it using

direct manipulation.
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� NOTE: Notice that nothing happened until you pressed

the <Enter> key! This is a big difference between modal

dialogs (with an OK button) and a modeless dialog:

Pressing OK on a modal dialog is like pressing <Enter>;

since a modeless dialog does not have an OK button,

you must explicitly press <Enter> for the value(s) in the

dialog to be updated.

� NOTE: You can enter several values into the dialog, then

press <Enter> once to have all the values updated at the

same time. This can save some time when updating a

vehicle’s position, since HVE-CSI re-renders the viewer

whenever the viewer’s contents change.
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Using Viewers

HVE-CSI uses viewers to display vehicles and the environment. Of course,
viewers are also used to visualize the motion of these objects during Event and
Playback modes.

HVE-CSI’s viewers have many features that make it easy for the user to select
how the objects are displayed. In particular, the user can perform the following
viewer operations:

• Resizing the viewer

• Panning the contents in the viewer

• Zooming in and out

• Dollying in and out

• Changing the camera position

These operations are described below.

Resizing Viewers

The size of the viewer is controlled by the user. To resize a viewer, perform the
following steps (refer to Figure 17-17):

� Close the Position/Velocity dialog still displayed on your
screen. Be sure Show Key Results has been selected from the
Options menu.

� Click on the left edge of the Key Results viewer frame for the
2009 Ford Crown Vic (note the cursor changes shape) and drag
it to the left. The viewer grows in width.

� Click on the lower edge of the viewer frame and drag it down.
The viewer grows in height.

� Click on the bottom left corner edge of the viewer frame and
drag it to the lower left corner of the screen. The viewer grows
in both width and height.

Notice by resizing the Key Results viewer, we’ve covered up the Event
Objects List viewer. Perform the following steps:

� Click on the left edge of the Event Objects List to bring the
viewer to the top of the desktop.

� NOTE: While viewers may be resized, most modal

dialogs cannot.

Spend a few moments practicing resizing the viewers and bringing various
desktop objects to the top of the desktop.
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Panning

Panning involves moving the scene horizontally and vertically within the
viewer.

To pan the scene, perform the following steps:

� Confirm the viewer is manipulate mode (the current viewer

mode is set by clicking on the hand icon along the upper right

edge of the viewer). If necessary, click on the hand icon.

� Place the mouse cursor in the middle of the viewer.

� Press the middle mouse button and drag to the right. You may

also press the left mouse button while holding down the <Ctrl>

key to perform the same operation. The viewer contents are

dragged to the right, as shown in Figure 17-18.

� Press the middle mouse button and drag to the left. The viewer

contents are dragged to the left.

� Use the same procedures to drag the viewer contents up and

down.

Spend a few moments practicing panning the contents in the viewer.
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Zooming In and Out

Zooming involves changing the lens of the virtual camera that HVE-CSI uses
to display the objects in the viewer. The current zoom status and zoom slider
are located along the right end of the lower edge of the viewer.

To zoom in, perform the following steps:

� Click on the Zoom slider and drag the slider to the left. The

camera zooms in on the scene. This is analogous to changing

from a 50 mm camera lens to a 150 mm telephoto lens.

To zoom out, perform the following steps:

� Move the slider to the right. The camera zooms back away

from the scene. This is analogous to changing back to a 35 mm

lens.

Zoom back to the original camera state:

� Move the slider back to the left until the scene returns to its

original size in the viewer, as shown earlier in Figure 17-18.

Dollying In and Out

Dollying involves changing the camera position, moving it closer to, or further
away from, the object (just like in filming a movie scene). To dolly in and out,
perform the following steps:

� First confirm the viewer is in manipulate mode: Place the

mouse cursor in the middle of the viewer and press the

<Escape> key. The viewer switches modes, as indicated by

the icons along the upper right edge of the viewer.

� Press the mouse cursor in the middle of the viewer and press

<Escape> again, and again, and again... Note the viewer

toggles between Pick and Manipulate mode. Leave the viewer

in Manipulate mode.

� NOTE: We’ve illustrated two equivalent methods for

switching viewer modes (clicking the viewer Mode icons

or pressing <Escape>. The method you choose is up to

you.

� Place the mouse cursor in the middle of the viewer.

� Press the left mouse button and drag down. The camera dollys

in, as shown in Figure 17-19.

� Place the mouse cursor in the middle of the viewer, press the

left mouse button and drag up. The camera dollys out.
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Let’s use a different method to dolly in and out:

� Click the mouse cursor near the top of the Dolly thumb wheel
(located along the lower right edge of the viewer) and drag
down. The camera dollys in.

� Drag the Dolly thumb wheel up. The camera dollys back.

� Click on the Dolly thumb wheel and drag the mouse cursor to

the top of the viewer. The camera dollys waaaaaaaay back.

� NOTE: We’ve just illustrated the thumb wheel’s range of
motion is not limited by its visible size.

� NOTE: We’ve also illustrated you can dolly in and out
using direct manipulation in the viewer or using the Dolly
thumb wheel. These two methods are equivalent. The
method you use is up to you.

Use either method (direct viewer manipulation or Dolly thumb wheel) to dolly
back in until the vehicle returns to its original size.

� NOTE: Both dollying and zooming appear to have the
same effect, that is, to make objects appear larger.
However, if you zoom in too close, the objects become
distorted just as if you were using a fisheye lens. For this
reason, we recommend dollying instead of zooming if
your goal is to get a close-up view.

Changing the Scale

The final task we need to learn about viewer manipulation is changing the current
display scale. This is a very important task because it allows the user to set the visual
display to a reference scaled based on a given “foot of environment model per inch of
screen display” (or meters per centimeter). This is extremely handy for those user’s
who use a transparency of a scaled aerial photograph or site drawing on the front of
their computer monitor as a quick means of setting-up events or comparing simulated
results to actual results. To change the display scale, perform the following steps:

� Select View, Set Camera from the main menu.

� Enter the value that you want to use for your scale in the data

field next to the word Scale.

� Press the Apply button to see the effects of your scale setting.

� If satisfied with your scale setting, press OK to close the Set

Camera dialog and continue working. Otherwise, change the

value entered for Scale and press Apply again.
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� NOTE: Changing the Scale value automatically adjusts
the vertical position Z of the camera. The Zoom value is
not affected by changes to Scale.

� NOTE: The value you enter for Scale should provide you
with the expected results on your display. However,
there may be some small discrepancies due to the brand
and model of your monitor.

As a final tutorial exercise, continue looking at various parts of the vehicle
using direct manipulation and a combination of panning (middle mouse or left
mouse + <Ctrl>), dollying (left mouse) and rotating (left mouse + middle
mouse or left mouse +<Ctrl> + <Shift>). Spend some time here! By mastering
the task of viewer manipulation, you will benefit every time you use HVE-CSI.
In particular, you will be able to work faster, and you will be able to better
visualize your work.

Shutting Down HVE-CSI

When you are finished working with HVE-CSI, you will end your session by
saving your work and exiting HVE-CSI. It is important to exit HVE-CSI
gracefully because HVE-CSI asks you to save your work if it has changed
since your last save, and because HVE-CSI updates your configuration file so
your next HVE-CSI session uses the same preferences and options you’ve
selected for use in the current session. HVE-CSI also saves the current editor
when you exit; thus, when HVE-CSI is next used, it will display the same
editor you were using when you last exited HVE-CSI.

To shut down HVE-CSI:

� Click on the File menu and choose Exit.

Because your work case file has changed since your last save, HVE-CSI asks
you to save or cancel these changes.

� Choose No.

HVE-CSI is shut down and you can now go have lunch.
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Lesson 2 - Running a Simulation
Lesson 2 is a high-level overview describing how to use HVE-CSI to set up and
execute a single event (reconstruction or simulation program). In this tutorial,
we’ll set up and execute an EDSMAC simulation.

For purposes of illustrating the basic procedures of running a simulation, we
will set up a very simple event: a vehicle turning right and accelerating up to
speed.

� NOTE: For a more comprehensive lesson, refer to the

Tutorial chapters in the EDCRASH and EDSMAC Users

Manuals.

In this lesson you will learn to perform the following tasks:

• Adding a Vehicle

• Adding an Environment

• Adding an Event

• Setting Up an Event

• Executing an Event

Mastering these tasks is important because you will perform these basic tasks
every time you use HVE-CSI - regardless of the reconstruction or simulation
model you’re executing.

Let’s get started. Before we can get into the individual tasks, we need to have
HVE-CSI up and running:

� If necessary, start HVE-CSI and arrange your desktop.

� NOTE: If you don’t know what we are talking about,

return to Lesson 1!

Selecting Vehicles

Let’s start by adding a vehicle to our case:

� Choose Vehicle Mode. The Vehicle Editor is displayed.

� Click Add New Object. The Vehicle Information dialog (also
called the Vehicle Wizard) is displayed. The Vehicle Wizard
allows the user to select the basic vehicle attributes according
to Type and Class.

� To select the type of vehicle, click on the Type option list and
choose Sport-Utility.

� To choose the size of vehicle, click on the Class option list and

choose Class 2.
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� NOTE: The Vehicle Wizard immediately displays the
vehicle dimensional and inertial parameters for the
selected vehicle. These parameters may then be edited
according to the specific vehicle in your study.

� Let’s change the name of our vehicle: Enter Typical Large

SUV.

� Click OK to add Typical Large SUV to the Active Vehicles

list.

The Typical Large SUV is displayed in the Vehicle Editor’s viewer, as shown
in Figure 17-20.

Again, visualize the vehicle, panning left, right, up and down and then
dollying in and out.

Let’s change the tire-road friction at each tire.

� Click on the right front tire. The Tire Information dialog for the

right front tire is displayed, as shown in Figure 17-21.

� Change the current friction value from 0.600 to 0.700,

followed by OK to accept the new values.

Repeat the above steps for the other three tires.
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Selecting Environments

Next, let’s add an environment to the case.

� Switch to Environment mode.

� Click on Add New Object. The Environment Information

dialog is displayed.

Let’s not bother with all the options here. But, we do want an environment to
drive on.

� Choose Open. The Environment Aerial Image File Selection

dialog is displayed (see Figure 17-22).
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Now, let’s select an image file for our EDSMAC event:

� Scroll down and choose 4x2-800ftx800ft.bmp.

� Press OK. The File Selection dialog is removed.

Next, in order to create the proper scale, we need to supply the earth-fixed
dimensions of the bitmap. As its filename suggests, the image is 800 feet by
800 feet. Let’s place the origin in the middle of the image:

� Enter X=-400 ft, Y=-400ft for the upper left corner.

� Enter X=400 ft, Y=400 ft for the lower right corner (see Figure

17-23).

� Press OK.

Next, let’s replace the default environment name (Untitled Environment):

� Enter Tutorial Lesson 2 Intersection

� Press OK.

The selected environment is displayed in the Environment Editor’s viewer.

Spend a few moments panning and dollying in and out until it appears as shown
in Figure 17-24.

� NOTE: We hope you are becoming an expert at using the

viewer controls to visualize objects. This is an important

part of becoming an efficient HVE-CSI user.
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Event Editor

Now, let’s get to the major focus of this lesson: Using the Event Editor. This
involves three steps:

• Adding the Event - This step involves choosing the vehicle(s)
and the calculation method (EDCRASH reconstruction or
EDSMAC simulation model) for the event.

• Setting Up the Event - This step involves assigning the
position and velocity for each vehicle in the event. This step can
also involve assigning driver controls and damage profiles, as
well as various program-specific options (these are found in the
program’s Calculation Options dialog).

• Executing the Event - This step involves pressing the Execute
pushbutton and observing the results. The first execution is
normally followed by adjustments to specific input parameters and
re-executing to improve the results. Additional runs may be
performed to identify potential sensitivities in various input
parameters.
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Let’s add our event:

� Switch to Event Mode.

� Click on Add New Object. The Event Information dialog is

displayed, as shown in Figure 17-25. Among its components,

the Event Information dialog contains the Active Vehicles List

and Calculation Method option list. These are the key

components required for creating an event.

� Note that the Typical Large SUV is already selected in the

Active Vehicles list and displayed in the Event Vehicles list.

� NOTE: If the Active Vehicles List has only one vehicle, it

is automatically selected to save you a step.

� Click on the Calculation Method option list and choose

EDSMAC.

� Change the default event name. Enter Turn Left and

Accelerate.

� Press OK.

We have created an EDSMAC event using the Typical Large SUV. The Event
viewer displays our environment, but no vehicle (yet).
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The next step is to set up our event. For our sample event, we’ll need initial
position and velocity and driver controls.

� NOTE: Initial position and velocity are required for all

simulations.

Let’s proceed:

� Note that Typical Large SUV is already selected in the Event

Vehicles list.

� NOTE: If our event included more than one vehicle, we

would need to select the desired vehicle before choosing

its set-up options.

� Choose Set-up from the menu bar. The Event Set-up options

for EDSMAC are displayed in the Set-up menu, as shown in

Figure 17-26.

� Only the event set-up options applicable to EDSMAC are

displayed in the Set-up Menu. That’s because each

physics program tells HVE-CSI which set-up options to

make available in the Set-up Menu.

� Select Position/Velocity. The Initial Position/Velocity dialog

is displayed and the Typical Large SUV appears in the Event

viewer at the earth-fixed origin (see Figure 17-27).

� Enter the initial position coordinates: Place the mouse cursor in

the X-coordinate field and enter -10.0 ft. Place the mouse

cursor in the Y-coordinate field and enter 25.0 ft.

� Check the Velocity is Assigned box to activate the Velocity

input fields.

� Enter the initial velocity: Place the mouse cursor in the Total

Velocity field and enter 5.0 mph, followed by <Enter>.

� NOTE: We just did something subtle but smart: We

waited until we had entered all our data before pressing

<Enter>. We absolutely must press the <Enter> key to

update the position and velocity. However, by waiting

until we entered all the data before pressing <Enter>, we

saved some time because the viewer was only updated

once. If we pressed <Enter> after entering each

individual coordinate value, the viewer would need to be

re-rendered three times.

� NOTE: Clicking the Apply button is the same as pressing

the <Enter> key.
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Now, let’s enter the steer table. For our example, we’ll enter a simple left turn:

� Choose Set-up from the menu bar. The Event Set-up options

for EDSMAC are displayed.

� Choose Driver Controls. The Driver Controls tabbed dialog is

displayed, with entries for Steering, Brakes and Throttle. The

Steering tab is displayed by default.

� Enter the steer table, as shown in Table 17-1 and Figure 17-28.
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Next we enter a throttle table to accelerate the vehicle while making its left
turn:

� The Driver Controls tabbed dialog is still displayed. Click on

the Throttle tab to display the Throttle table.

� Enter the throttle table, as shown in Table 17-2 and Figure

17-29.

� Press OK to accept the driver control tables.
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Next, let’s increase the length of the simulation time. The default is 5 seconds;
we’ll make it 10 so we’re sure the vehicle completes the turn before the
simulation ends. To increase the maximum simulation time:

� Choose Options, Simulation Controls. The Simulation

Controls dialog is displayed (see Figure 17-30).

� Change Maximum Time to 10.0 from 5.0.

� Press OK.

The simulation will now run for 10 seconds.

Use the Event Controller, shown in Figure 17-31, to execute the EDSMAC
event. The Event Controller’s buttons have the following functions, as
described from right to left:

• Reset - Reinitialize the calculation model for re-execution

• Rewind to Start - Return to the start of the simulation

• Reverse - Play the simulation backwards

• Pause - Pause the simulation

• Execute/Play - Execute the event or play the simulation forwards

• Advance to End - Advance to the end of the simulation

17 - 36

HVE-CSI Lesson 2 - Running a Simulation

������ �6�*: "�� ���������	 ��	����� ������ ������ ���
���� �� #��	�� ������� ���������	 #�	���� ����������
�	#����	� ��� ��'���� ���������	 "����



� NOTE: If you make changes to any of the event set-up

options (Position/Velocity, Driver Controls), those

changes will have no effect unless you press Reset

before pressing Play.

To execute the event:

� Press Execute/Play.

The Typical Large SUV begins moving as its motion is simulated according the
vehicle model, tire-road friction, initial position and velocity, and the specified
driver steering and throttle inputs. See Figure 17-28 and 17-29. The vehicle
simulation continues until the maximum simulation time, 10.0 seconds, is
reached.
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Let’s replay the event a few times, illustrating some useful options.

� Using the Event Controller, press Rewind.

� NOTE: Pressing Rewind allows us to rerun the event

without re-executing the simulation; it simply redisplays

the current simulation in real time (if your computer

graphics display is capable).

� NOTE: Because most computers are quite powerful,

replaying the event in real time actually slows down the

display!

As technical people, we tend to be interested in numeric data (as opposed to
simply a nice animation of the motion). These numeric results are displayed in
Key Results windows for each timestep while the simulation is displayed. Our
example includes a Key Results window for the Typical Large SUV. If a Key
Results window is not displayed on your desktop, let’s display it:

� Choose Options from the menu bar, and click Show Key

Results. The Key Results window for the Typical Large SUV is

displayed.

By default, the vehicle’s Sprung Mass Kinematics results are displayed. Let’s
add Tire Forces to the Key Results window:

� Click on Select Variables in the Key Results window. The

Variable Selection dialog is displayed (see Figure 17-33).
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The currently selected variables for the Kinematics output group are
highlighted. Let’s select the new output variables to be added to the Key
Results window:

� Click Wheels, Axle 1, Right.

The Variables list box for the select wheel is displayed.

� Scroll down and select Fx, Fy and Fz.

� Press OK.

The selected variables are added to the Key Results window (scroll down or,
better yet, drag down the bottom of the Key Results window to increase its size
so you can see all the window’s results). The Event Editor with the Key Results
window is shown in Figure 17-34.

� Using the Event Controller, press Execute/Play. The event is

redisplayed, showing the selected Key Results for each

timestep.

Spend a few moments replaying the event from different views, panning and
dollying in and out, using the techniques you learned earlier.

17 - 39

Lesson 2 - Running a Simulation HVE-CSI Tutorial

T
U

T
O

R
IA

L

������ �6�*, ���	� ������ ���� A�� 4������ ��	��� ��� ����	� ���� )��#�� )�� ��� �����
)��	� �����



� NOTE: Like all events, our EDSMAC event has produced

several output reports (Accident History, Messages,

Vehicle Data and several others). The Playback Editor is

used to view and print these reports. Refer to the

EDSMAC Program manual for further information.

This concludes Lesson 2 - Running a Simulation model. You can go ahead and
shut down HVE-CSI or proceed directly to Lesson 3.
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